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ORDERING THE FULL VERSION

READ THIS FIRST    - The 
latest information and important considerations
New Features - A brief introduction to features new in this version.
Introduction - Introduction to the program
Using The Program - A guide on how to use Illuminatus
Reference Guide - A complete reference of functions and commands
Tips & Technical - Tips for using Illuminatus and technical issues

Conventions
In this help file worked examples are in Bold Italic text; 
RED text is used to show text you type while using the program, 
BLUE text designates menu options and text on screen labels or buttons or keys to be pressed



Fonts
Illuminatus supports True Type fonts and so allows you to use any font you currently have installed under 
Windows. There is no need to restrict your choice to those you think your readers will have or to distribute
the fonts with your publications as Illuminatus automatically converts them to graphics when you compile 
or publish your document.

When selecting fonts with which to display text you should think about the manner in which they will be 
read. Small sizes and fancy typefaces will probably not work well when displayed on screen; they are 
particularly unsuitable for rolling demos where the message must get across quickly. As with all publishing
it is advisable to limit yourself to one or two typeface styles in any one document as this give the 
publication consistency and coherence.

Text



Introductory Topics
Welcome
Introduction
Learning Illuminatus
What is Multimedia Publishing



Using the Program
Quick Start
A brief overview on how Illuminatus works for users who cannot wait to get started.
How it Works
A more detailed overview of the how the program works for experienced Windows users.
Creating Your Publication Efficiently
Resources & Data Files
All you need to know about graphics, music, video and animation, and how to use them in Illuminatus.
Reference Guide
A comprehensive guide to all the options and dialogs you willl come across in Illuminatus. Plus additional 
reference information for a full understanding of the functionality of Illuminatus.
Commands
A comprehensive guide to each command in Illuminatus and what it does.



Tips & Technical
Important Considerations
Some things to keep in mind when designing your multimedia publication and the resources you plan to 
use in it

Other Hints and Tips
Technical Details
About Illuminatus



Read This First
Black Page Backgrounds and Frames
If frames or backgrounds of your publication are black where you expect graphics to be this is because 
Illuminatus cannot find the resources in the publication. Use Check Location to find the resource files and 
reassign the publication to use them from the new location. Where only the drive has changed and the 
directory structure is the same you can reassign all the data files by using the Change Data Drive option.

Sharing Violation Error
If you get a Windows error message saying that a sharing violation has occurred while running your 
Illuminatus publication this is usually because the publication has tried to play some music which is 
already playing. For example if your first page launches some music which loops continually in the 
background and then another page takes you back to that first page Illuminatus will attempt to launch the 
same music again and the sharing violation will be noted. To avoid this happening simply set "Stop 
Existing Sound". This way the original file will be closed before it is rerun and the error will not occur.

Test Thoroughly
We have made Illuminatus easy to use and it may appear simple but the mechanics of what it is actually 
doing are quite complex. We recommend that you test your compiled and published publications 
thoroughly to ensure that everything works as you intended it to. Try to get someone who hasn't seen it 
before to try it out. This can often highlight problems or requirements you hadn't predicted. 

If you are distributing your publication to others it can also be useful to test your publication on another 
computer or in a different graphics mode to ensure that it looks as you would wish.

Compile Times
Compile and Publish will take slightly longer when you Compile or Publish to a colour scheme different 
from the one you are working in. This occurs because Illuminatus has additional work to do reducing the 
colours in each page.

Compile and Publish Problems
If your publication fails to compile\publish properly or doesn't run properly once compiled. Use check 
location to check all your resource files. Check your available memory and system resources. Check your
free disk space. Free as much system resources as possible and try again. This will often solve the 
problem.

Temporary Files
Illuminatus creates temporary files when publishing and compiling. The size of these depends on the 
number of pages in your publication and the resources you are using. A simple publication of five or six 
pages may require 2Mb a twenty page publication with video and sound effects may require 30Mb.

Big Publications
Publications with a large number of pages can be slow to work with so you may like to consider breaking 
the publication down into sections and creating each of these separately. You can either daisy-chain them
as described in Advanced Features or if you need your final publication to be a single file you can cut and 
paste the modules together at the last minute.

Titles
Do not forget to add titles to slideshows, animation and video in the box provided or these elements will 
not be visible throughout the rest of the program. (See Titles and Filenames    for further details).

Speed
Illuminatus will run on any PC which will run Windows 3.1 but the program will be more enjoyable to work 



with on a 66Mhz 486 or better. If you are running it on a slower machine or do not have a graphics 
accelerator you can speed up the program by switching off the thumbnails used to preview pages in the 
Publication View and by not previewing bitmaps in Page View. Both of these options are available from 
the Preferences item on the File menu.

For obvious reasons display of multimedia pages from within the Illuminatus Editor using the Preview 
option will be considerably slower than the final Compiled or Published version.

Media Clipart Licence 
The graphics and sound files which come with this program are copyright Digital Workshop and Words & 
Pictures. They can be used freely in commercial or non-commercial publications produced with 
Illuminatus but MAY NOT be distributed separately from the Illuminatus program or a multimedia 
publication created with it.

Additional Licences
Additional licences for Illuminatus are available in 5 and 10 User packs. Special rates are available for 
educational licences.

Free Upgrades
Digital Workshop is committed to fair play on upgrades. We will have maintenance releases to fix bugs 
and upgrades to add features. Maintenance releases will be free although a small handling and postage 
charge may be necessary for customers who do not have access to Compuserve or CIX where 
maintenance releases will be made available. Please note however that when we release a general 
maintenance upgrade only registered users will be sent it automatically. Registering your copy of 
Illuminatus tells us your actively using it so we can actively support you.

Free Disk of Backgrounds
You also receive a FREE disk of backgrounds when you register.

Tabbed Dialogs
The new tabbed dialogs allow us to add extra options to the frames and buttons without changing the 
simple approach we began in version 1. Please note that the Summary on the front of each set of dialogs 
allows you to switch options on and off conveniently, the information cannot be edited there.

Related Information
Important Considerations
Other Hints and Tips



New Features
There are a great many changes and improvements in this version of Illuminatus. The following details 
some of the most significant ones.

Smaller Publications
Illuminatus now compresses all page data and its data files so that publications take much less hard disk 
space. In addition the Compile and Publish now check for duplicate images, audio files etc and only 
include one copy of any duplicated on another page of your publication. This means both editable and 
distributable publications take up much less disk space.

Faster Publications
Your distributed publication now buffers the pages in memory as much as possible. This means that 
publications take a while to load but are much quicker to view. This means publications can now run much
better direct from floppy.

Editable Templates
Frames and buttons can now be moved and resized as you like and can be added and deleted as 
required. You can add entirely blank pages to your publication to create templates from scratch. 
Editing Page Elements

You can also align the buttons and frames on a page. 
Align

Extension Programs
The Launch Program option for can be used for extending Illuminatus, particularly as Illuminatus can now 
start up on a particular page passed to them as a parameter.
Launching Other Programs
Extension Programs

Reporting Text
Buttons can now save text to a disk file thus enabling scoring, checking and such like. Combining this with
extension programs which analyse and act on the resulting text files can be very effective and useful.
Button Options

Page Options
A number of additional options are now available for pages. They can be displayed using special effects. 
They can be individually timed to appear for a certain period and can have music or sound associated 
individually.
Page Options

Keyboard Support
Buttons can now be assigned a hot key so that they can be activated by pressing a key on the keyboard 
rather than only with the mouse.
Button Options

New Commands

Data Files
Check Location
Change Data Drive
Consolidate Project



Insert Blank Page

Add
Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom



Welcome
Thank you for purchasing Illuminatus. We hope you enjoy exploring the opportunities multimedia 
publishing offers.

Digital Workshop is committed to really user-friendly software and customer-friendly service. We are 
trying to build software that works the way you do, that needs the least effort from the user. We're also 
playing fair on upgrades so you will never have to pay for features you do not need to fix bugs which 
should not have been there in the first place.

Of course we won't always get it right so when we get it wrong please let us know and you can be sure 
we'll do better next time.

Give us a call or contact us via our conference on CIX ( join theworkshop\illuminatus) or Compuserve GO 
WORKSHOP 

Other Introductory Topics:
Introduction
Learning Illuminatus
What is Multimedia Publishing?



Introduction
Illuminatus is a multimedia publisher. It is a way of quickly and easily combining the myriad of multimedia 
resources which are now available into an interactive multimedia document which you publish in digital 
form on your hard disk or onto a floppy or CD ROM. 

Illuminatus is not a multimedia presentation package although it will perform a similar function more than 
adequately but it will do far more than that and because it is versatile but simple and easy to use it offers 
the opportunity for multimedia publishing for everyone. 

Illuminatus is powerful enough to create a full blown computer-based training package or multimedia 
programs and yet is so quick and easy to use that it can be used to write multimedia memos or even 
greetings cards for friends and colleagues.

Illuminatus can produce an independent Windows program which runs and installs just like any other 
Windows program and yet it is so easy to use that you need no programming skills. It works on similar 
principles to DTP programs now familiar to millions.

Other Introductory Topics:
Learning Illuminatus
What is Multimedia Publishing?



Learning Illuminatus
The first step in learning to use Illuminatus is to read the Getting Started booklet which comes with the 
program. This is not a comprehensive reference manual but instead provides a quick overview and 
tutorial introducing the most salient points of the program. 

An online tutorial is also provided which compliments the Getting Started manual with a visual introduction
to the program and its features.

This online manual provides all the additional information you may need providing a comprehensive 
reference for all the functions of the program as well as hints and tips, technical information and late-
breaking news. It also provides context-sensitive help from the various dialogs in the program.



What is Multimedia Publishing?
Multimedia is one of the most exciting forms of communication available to us today but until now creating
multimedia communications was a difficult and demanding job. Now Illuminatus introduces multimedia 
publishing which extends the concept of desktop publishing into the audio-visual, interactive realm of 
multimedia. With Illuminatus interactive multimedia programs can be created as easily as a DTP 
document and published in digital form for distribution on floppy disk, CD Rom or across the Internet. 

Multimedia is already a favourite tool for the business presentation professional. Illuminatus offers the 
ability to quickly and easily add multimedia pizzaz to standard business presentation and promotional 
items but also allows you to extend presentation and promotion into new modes by easily adding 
interactivity and distribution of the finished publication.
Illuminatus is so simple to use that you don't need to be an expert to use it. Thus you can be an expert in 
something else and yet develop an interactive multimedia application.    It provides an ideal opportunity for
enthusiasts and specialists to pass on their knowledge in this most exciting and effective way. It is also 
particularly useful where confidentiality is an issue and where the involvement of as few additional parties 
as possible is required. 

Furthermore, you can also tailor your project to your own needs, capacities and budget so interactive 
multimedia comes into the reach of small businesses and    even individuals. 

Multimedia Publishing offers "books" which can include sounds, and moving images as well as words and
pictures, and which can be interactive. That is, they do not have to read page by page but allow the 
reader to choose the course of their study.

Multimedia publishing also offers the creative person an opportunity for creativity beyond what was 
previously available. A single creative artist can command words, pictures, music, sound and filmic 
images into whatever combination he or she desires.

As implemented by Illuminatus multimedia publishing works in much the same way as DTP except that 
the documents it publishes are published in computer form rather than on paper. Illuminatus makes 
multimedia publishing easy and will publish onto floppy disks so that it makes it possible to produce 
multimedia versions of even simple documents such as memos and greeting cards.

Multimedia publishing is extraordinary communication for ordinary people. Illuminatus is multimedia 
publishing at its easiest.

Illuminatus - mirable dictu, mirable visu



Quick Start
Illuminatus is simple to use. When starting with a new publication you get a blank window which provides 
an overview of your publication.

You can build your publication from any combination of pages and page templates which you can insert 
from those options on the Publication Menu or using the relevant buttons on the toolbar. You then click in 
your publication window at the point where you want the pages inserted. A wide selection of skeleton 
pages (page templates) is provided for you to get started. Or you can insert a blank page in the same 
fashion and then add frames and buttons as required.

Insert however many pages or page templates you need from the wide selection available. 
Publication View

Double click on any page to edit it. 
Page View

Double click on the background to edit the basics of the page, its colour or background picture, to attach a
sound or music, to display it with a special effect or for a certain length of time.
Page Options

To reposition a frame or button simply drag it to where you want it to be. To reshape and resize a button 
or frame drag one of the eight handles which appear around it when selected to create the shape 
required.

To add frames or buttons select Add|Frame or Add|Button from the Edit menu or click the appropriate 
button on the toolbar. Click on your page where you want the top left corner of your frame or button and 
then drag down and right to create the object.
Editing Page Elements

Double click on a frame to load its contents, colour, picture, animation, slideshow, text etc, to alter its 
precise size and location and its border style. 
Frame Options

Double click on a button to give it a caption and connect it to an event (launching a video, slideshow, 
animation or moving to another page, etc.) and to alter its precise size and location.
Button Options

Preview the complete document using the Preview button.
Preview

Save your publication to disk using Save Publication As from the Save submenu of the File menu or use 
Consolidate Project to save your publication and copy all the files it needs into the same directory for 
convenience.

Once you have completed your document you can produce an independent program by compiling it on to 
your hard disk or publishing it onto floppy disks (from the Publication menu). Set your Installation Options 
and Publication Options to specify a title for your publication and the details to build it into a distributable 
form. You can choose an icon for your publication and create it in mono, sixteen, 256 or 16.7million 
colours and Illuminatus will handle any colour changes automatically.

Compile
Publish



NOW READ
Important Considerations



How It Works
Illuminatus works in a similar way to several popular DTP programs in providing frames into which you 
place text and/or graphics (including video and animation) to build up a "page" and then a complete 
document. In addition it provides buttons which allow the reader to move around the "book" and which 
can be used to launch events within the book.

Start Up
The program starts up in Publication View [see Publication View ] - an overview of your whole document, 
showing all the pages in it as icons with a title beneath it for easy reference. You can choose to view an 
accurate thumbnail of the page by selecting Thumbnails of Pages in Publication View from the 
Preferences option from the File menu. You can choose to open a publication from disk, load up the bare 
bones of a complete publication by choosing New from Template; or to start entirely from scratch by 
selecting New Publication.

If you are using the Illuminatus title page to choose the way you start you can also open the last 
document you used. If you are already within the Illuminatus editor you can choose from the last four you 
used by selecting the appropriate filename from the list on the bottom of the File menu.

You can open more than one publication at a time if you wish. (See Multiple Publicationsfor further 
details.)

Publication View allows you to organize the pages of your publication. You can select as many as you like
and can Cut, Copy, and Delete them as required. (See Selecting and Moving Pages for further details.)

Preferences and Options
Publication View also allows you to set up the way your multimedia publication and Illuminatus itself 
works. You can set up certain aspects of how Illuminatus runs, via the Preferences option on the File 
menu including - keeping a backup copy of your publication when you save it, preview thumbnails and 
bitmaps and whether to skip the title page on start up. It will also let you play background music while you 
work and set the colour of the Help tags which appear over the toolbar buttons.

There are several general options you need to set up for each of your publications. You can set a title and
details of the installation of the distributable version of our publication via the Installation Setup option on 
the Publication menu. This dialog also lets you set a title for the publication which appears in the title bar 
of the publication and beneath the icon,    a default directory into which the setup program will install your 
multimedia publication and the icon it will use in Program Manager. You can also set the size of floppy it 
should be created for.

Note: You must give your multimedia publication a title before you compile or publish it.(See Installation 
Setupfor further details.)

General Options
Illuminatus provides a number of options which apply to the whole publication and these are accessed via 
Publication Options on the Publication menu. This dialog allows you to set up how the publication can be 
interrupted and how it closes. If the publication is going to be used unattended you may like to protect 
interruption of it with a password.

This dialog also allows you to reset the publication automatically. If your interactive publication is being 
used unattended it will almost certainly get left at various points as users find what they wanted or finish 
using it. On such occasions you need to be able to return your publication to the opening page. The Auto 
Reset option allows you to do just that. 



Building Your Publication
Your publication is constructed from up to 500 screen pages built up of frames and buttons over a 
background colour or design. A wide range of pre-defined template pages are provided for you to start 
with or you can design your own from scratch. Insert pages, page templates and master pages by clicking
on the appropriate button on the toolbar or via those options on the Publication menu.

A frame can display text, graphics, video, animations or Illuminatus slideshows, or any practical 
combination of these. Double-click on the frame to bring up a set of tabbed dialogs allowing you to "load" 
these elements into the frame and set various options for them. You can type text in directly or import it 
from an ASCII file on disk. You can search for pictures, videos or animations using the file list boxes on 
the bottom of the dialog. Remember, these elements need a title to be visible in the rest of the program.

There is a summary at the front of the dialog which allows you to set the exact position and size of the 
frame, to switch the elements on and off conveniently without needing to go to the appropriate section, 
and to assign a border style for the frame.

If you need two or more similar types of object in the same place you can draw an additional frame to 
contain each and position them over each other in the order required. Layers can be reordered using the 
Move|To Front and Move|To Back options on the Edit menu in Page View.

If you want a consistent design and colour scheme to your publications you can save an edited page as a 
Master Page with all the settings, graphics etc. intact. If you have pages you want to use in more than one
publication or which will only change slightly from publication to publication you can save the page 
independently of the publication using Save Page from the File menu in Page View. Both of these options 
are useful for any elements of a document which stay consistent over different pages or different issues 
e.g: cover, contents page, index, product details etc.

Buttons provide the actions for your publication. Double-click on the button to bring up a set of dialogs 
allowing you to assign actions to it and give it a caption. A button can move between pages, close the 
publication (as set up in Publication Options on the Publication menu) or launch a video, animation, 
slideshow or another program. It can even launch another multimedia publication.

A button can also be used to play a sound, stop a movie and to send a piece of text to a specified file on 
the hard disk. This latter enables you to track what your user is doing if you wish.

Publishing Your Multimedia Document
Once you have built your publication you need to create a copy which will run outside Illuminatus. For this
you need to Compile or Publish it. 

The former builds a working copy of the publication onto your own hard disk and does not create an install
program or build all the associated files into the publication as they can be accessed where they are. This
is useful for publications you want to have an installed copy of and for rolling presentations for shop 
windows and exhibitions.

The latter builds a distributable copy of your publication by collecting together all your data and any 
programs you want to launch with supporting files or materials (as set up in the Publishing dialog which 
comes up when you publish your project. All the material is then combined and compressed (optional) 
and wrapped in a standard Windows setup program. If necessary it is then chopped up into segments 
small enough to fit onto the type of floppy you have chosen (using Installation Setup on the Publication 
menu). This copy is then built into a directory of your choosing on your hard disk with each diskful going 
into its own subdirectory. (This is much quicker than publishing directly onto the floppy drive). You can 
then copy the publication segments to floppy at your convenience using File Manager, the DOS Copy 
command or your favourite file management program.



Reference Guide
Click on one of the following topics for a comprehensive reference on that subject.

Publication View
Installation Setup
Publication Options
Page View
Button Options
Page Options
Frame Options
Preview
Compile
Publish
Preferences
Commands
Resources and Data Files



Publication View
Publication View is an overview of your entire publication showing all the pages in it. If you have the 
Preview Thumbnails option turned on (Preferences on the File menu) each page is represented by a 
miniature representation of the actual page and a title. You edit the title by typing it into the box provided 
on the toolbar in Page View.

To edit a page simply double click on it in Publication View. If the page is already selected you can simply 
press Enter.

You can switch backwards and forwards between Page View and Publication View by pressing F4.

Here is a list of the commands available in Publication View. Simply click on any of them for further 
information on their function

File
New...

New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project

Print
Printer Setup
Summary Info
Preferences
Exit

Edit
Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page

Publication
Publication Options
Installation Setup
Insert Blank Page
Insert Page Template
Insert Page
Insert Master Page
Compile



Publish
Preview

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

Further Information 
Selecting and Moving Pages
Multiple Publications
About Templates

Related Topics
Preferences
Installation Setup
Publication Options
Preview
Page View



Preview
This function allows you to preview your publication. It runs the publication as it will be displayed on your 
reader's machine and allows you to view the design and test buttons and so on.

You can run Preview from both Publication View and Page View by pressing F5. 

Please note: Preview is still referring to the original files to create your publication and so is considerably 
slower than the final version will be. To accurately preview the speed of your publication you should 
compile it and run that version outside the editor.



Installation Setup
This option allows you to set your preferences for the way your distributable multimedia publication will be
installed. 

You can select a title (you must have a title for the publication before it can be published). This title is 
used as your publications name under Windows - it is used under the icon and in the title bar of the 
publication's window. The title is not the same as the filename for the program element of your 
publication.

You can setup the directory which will be used as the default when your reader installs your publication. 
(They can change it to suit if required.)

You can also choose an icon which will represent the publication in your reader's Program Manager. Use 
the Browse button to locate and open the file you want.

You can also set the size of disk you will be publishing your publication on. Click on one of the three 
options provided to select either 3.5"HD, 3.5"DD or 5.25"HD disks. This information is only used when 
you Publish your publication. The Compile function does not divide you publication into disk-sized chunks.
If you wish to produce material for CD Rom you can ignore this setting because you will want to Compile 
rather than Publish. 

This dialog can be called up from the publishing dialog when you come to it but the title must be 
established in advance. Illuminatus will prompt you for a title if you haven't set one.

Related Topics
Preferences
Publication Options



Titles & Filenames
To make Illuminatus easy to use it uses user-defined titles to refer to things rather than filenames. 
Whenever you select an animation, slideshow or video to go into a frame you must give it a title by typing 
it into the box provided. This allows a much more descriptive name than the eight letters of a DOS 
filename and also allows you to use the same animation in more than one location and still know which 
one you are referring to when launching it.

When you want to add such an event to a button you can then choose the element by its title in the drop 
down list box provided.

Pages have titles too. These are shown in a box in the toolbar in Page View and can be edited there. 
They also display in Publication View as an aid to identification.

Publication Titles
Publications also have titles. A publication's title is the name which appears in the menu bar of the window
of your publication and beneath the icon in Program Manager. It is also used by the setup program. These
are set up via the Installation Options dialog.If you try to compile or publish your publication before you 
have set a title Illuminatus will prompt you for one as it is required before both Publish and Compile can 
proceed successfully. You will only need to set the title once although you can change it at any time if you 
wish to.



Publication Options
This set of dialogs lets you set up options which apply across the whole publication.

Reset
This establishes how long your publication will wait before it decides it is not being used anymore (type 
the number of seconds in the box provided) and what it will do then. The options are to go to a specific 
page or to closedown. You can select a sound or music file to accompany this event.

Closedown
This is what will happen when your publication exits. It allows you to display a final page or play a sound 
file if you so wish. 
Be careful you do not display a final page which itself has a button to call closedown as your publication 
will end in an infinite loop and you'll never be able to close it.

Exit
his dialog lets you specify what keystroke can interrupt your publication and force it to exit. The standard 
Esc and Alt+F4 are provided. You can prevent unauthorised exiting of your publication by assigning a 
password to the exit procedure.

Related Topics
Preferences
Installation Setup



Page View
Page View shows your publication one page at a time so that you can see the various page elements to 
edit them. You can work on your entire publication in Page View by moving backwards and forwards 
through the project using the slideshow buttons provided or using the cursor keys and Home (to jump to 
the first page) and End (to get to the last page).

You can also jump to any chosen page simply by selecting its title from the drop down list of page titles in 
the toolbar.

Page View allows three levels of zoom - Zoom 100% (for previewing the page exactly as it will appear), 
Zoom 50% (so you can see the whole page with reasonable detail) and Zoom to Fit (scales the page to fit
the whole page into the current window). 

Most users will find it most convenient to use Zoom to Fit with both Illuminatus and the publication window
maximised

The Page Elements
An Illuminatus page consists of three elements...

Page - Certain elements and functions can be applied to the whole page. You can display it for a 
specific length of time, select a special effect with which it will appear and/or disappear and play 
background music or sound. The background of a page can be coloured and/or can contain a graphic 
which is either an illustration or an attractive pattern or which imposes a design on the publication.

Frames - these are the boxes into which text, graphics, animations and/or slideshows can be 
loaded. They can have a background colour or can be transparent (select the background colour None). 
They can have a selection of different border types.

Buttons - these control the actions of an Illuminatus publication. Unlike standard buttons they 
can have multiple line captions. They can also be invisible which enables them to be used as hotspots as 
they are not visible but can still perform the action assigned to them and so can be placed under a 
graphic so that when the user clicks on the graphic he/she is clicking on the invisible button. 

Editing the Page
To edit the various elements on a page you simply click on them and drag them to wherever you want 
them to be. If you want to resize them there are eight small black "handles" on the corners and in the 
middle of each size. Click and drag on these to alter the size and shape of the frame or button. 

You can also edit them by typing in the appropriate figures in the boxes on the Summary dialog.

To add additional frames or buttons you select Add|Frame or Add|Button from the Edit menu or click on 
the appropriate button on the toolbar. You then click on your page where you want the top left corner of 
your frame or button to be and then drag down and right until the object is the right size and shape before 
releasing the mouse button.

To edit the contents of the page elements simply double click on the appropriate element this brings up a 
set of dialogs which allows you to set the options appropriate to that element.

Both frames and buttons can be hidden to "remove" them from your page when they are not required. 
This also allows you to change the design of the page to some extent without editing the template or to 
retain alternative versions of the same publication in the same file.

This is a comprehensive list of the commands available in Page View. Simply click on one for further 
information on the function.



File Menu
Save...

Save Publication
Save All Publications
Save Publication As
Save Page As
Save As Master Page
Save Page As Template

Export Page
Print
Printer Setup
Return to Publication View

Edit Menu
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom

Page Menu
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

Related Topics
Preview
About Master Pages



Editing the Page Contents
To edit the contents of frames, buttons and whole pages you simply double click on the appropriate 
element and then select the tab for the option you wish to edit.

Page Options
Frame Options
Button Options



Editing Page Elements
To move the frames or buttons on a page you simply click on them and drag them to wherever you want 
them to be.

If you want to resize existing frames and buttons there are eight small black "handles" on the corners and 
in the middle of each side which appear when you click on the frame or button. Click and drag on these to
alter the size and shape of the element. If the handles overlap another object you can sometimes miss 
the handle and inadvertently select the object beneath. To avoid this ensure that you click the point of the 
cursor in the very centre of the handle.

You can also edit the size and shape of buttons and frames by typing in the appropriate figures in the Top,
Left, Width, Height boxes on the Summary dialog.

To add additional frames or buttons you select Add|Frame or Add|Button from the Edit menu or click on 
the appropriate button on the toolbar. You then click on your page where you want the top left corner of 
your frame or button to be and then drag down and right until the object is the right size and shape before 
releasing the mouse button

You can delete any frame or button, together with its contents by pressing the Delete key or choosing 
Delete from the Edit menu in Page View

You can select multiple items by holding down the Shift key while clicking on the objects required. Only 
Delete and Align work on multiple objects.

Add
Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom



Page Options
Double click anywhere on the background of a page to bring up the set of Page Options dialogs.

Summary
The summary allows you to set the length of time the page will be displayed (optional). This is mainly 
intended to allow you to produce a non-interactive rolling demo.
It also allows you to switch the various other options on and off conveniently.

Background
You can add a background colour to your page. Clicking on the Palette button brings up a standard 
Windows colour-selection dialog from which you can choose any of the ready-made colours or create 
your own by clicking on the Define Custom Colours button.

Note: This colour is the colour used to surround your publication if it is run in 800x600 or larger mode. It is
also used for the blank screen between pages so it can be important to set this colour even if a picture 
normally fills the background of your page.

You can also load a picture in any of the supported graphics formats by using the file list boxes at the 
bottom of the dialog to find it on your disk. Checking the Scale to Fit option will resize the picture to fill the 
background, with the Keep Aspect option checked the picture will not be stretched out of proportion in 
order to make it fit. The scale to fit option is not relevant for vector format pictures such as .WMF 
or .CGM.

The background picture can be a texture, an illustration or a graphic which designs the publication in a 
certain way.

Display
This option allows you to choose a special effect with which your page will appear on screen or disappear.
Using the Over Existing Page option you can specify whether the page should appear over the preceding 
page over whether it should go to a blank screen first (the colour of this blank screen is set by the 
background colour setting on the Background dialog).

Sound
A button can also play a piece of music or sound effect. You can set this up via the Sound tab. Use the file
list boxes to find the file you want to play.

Selecting Loop will play the file repeatedly. 

Delay enables you to synchronise the sound with another event or time it for some other reason.

Stop Existing Sound will stop any background music playing but please note that two files of the same 
type cannot be played at the same time anyway so this is only relevant if you are playing a midi track and 
want to launch a WAV file or vice versa.

You can ensure that the sound does not continue when you move onto the next page by checking the 
Stop on Next Page option. To provide background music for your entire publication simply start a sound 
on the first page without checking this option and the music will continue until another button or page 
stops it.



Frame Options
Whenever you double-click on a frame you call up this set of dialogs which allows you to setup the 
contents on any frame. Frames can contain text, graphics, animations, video or slideshows. A frame can 
contain all these elements although you cannot run a slideshow, video and/or animation at the same time,
whichever is launched last will overplay the other.

The Summary on the front of the dialog allows you to switch the options on and off conveniently. It also 
allows you to specify a style for the Frame Border. Simply click on the style you want in the drop down list.

You can also edit the exact size and location of the frame here by editing the figures in the Top, Left, 
Width and Height boxes.

If you want a frame to be transparent set the colour to None but note that the background of any bitmap 
graphic in the frame will not be transparent, only vector images are pasted transparently onto the page.

Related Topics
Text
Graphics
Slideshows
Animations
Video



Button Options
Double-clicking on a button brings up this set of dialogs which allows you to assign actions to buttons. 
You can use buttons to move around the publication or to launch events. 

The Summary on the front of the dialog allows you to set the actions for buttons and to switch the options 
on and off conveniently.

You can also edit the exact size and location of the button here by editing the figures in the Top, Left, 
Width and Height boxes.

The button can be activated automatically by setting the AutoStart and Delay options as appropriate. 

Hot Key
If you want the button to be operated by the user pressing a key as well as using the mouse you can 
assign a single letter to the button which will activate it whenever that key is pressed. The hot key does 
not distinguish between upper and lower case characters so it doesn't matter if your user has CapsLock 
on or not.

None
The None option clears the other mutually-exclusive options and thereby allows you to use a button to 
play a sound and/or stop an animation without performing anything else.

CloseDown
Exits the program via the Closedown routine as specified in Publication Options.

Go to Page
Move the publication to the page chosen. Select it from the drop down list provided. It is as well to have 
set up all the page titles before you start assigning buttons to move to them as the button will not find the 
page if you change the name subsequently.

Slideshow
Launches a slideshow chosen by selecting its title from the drop down list. You must have set up a frame 
with a slideshow in for the button to refer to. Slideshows

Animation/Video
Launches an animation or video file chosen by selecting its title from the drop down list. You must have 
set up a frame with a video or animation file in for the button to refer to.
Most of the options are mutually exclusive - you can only use a button to perform one main action. There 
are two additional actions which a button can be assigned at the same time as one of the main functions 
and those are to play a sound file and to stop a slideshow or animation. Thus a single button could stop 
the animation running on the current page, play a fanfare and move onto the next page. Moving Images

Launch another program
This enables you to launch another program from within Illuminatus. You can set this option up via the 
Launch tab. 
You can simply type the name of the program in the box provided and type a parameter command or or 
assign a data file to be run with it by typing that in the With Parameter box. Alternatively you can use the 
file list boxes to locate the program you want to run and/or the file parameter for the program or assign a 
data file to be run with it. In this case use the Add as Launch and Add as Parameter buttons to copy the 
file details into the appropriate boxes when you have selected the file.

An example of this would be to launch the Powerpoint Viewer program (PPTVIEW.EXE) and with the 



presentation you wanted it to view given in the With Parameter box.

You can also select whether your publication should close when the other program has been launched 
and whether you want to distribute the files you are using.

See also
Launching Other Programs

Sound
A button can also play a piece of music or sound effect. You can set this up via the Sound tab. Use the file
list boxes to find the file you want to play.

Selecting Loop will play the file repeatedly. 

Delay enables you to synchronise the sound with another event or time it for some other reason.

Stop Existing Sound will stop any background music playing but please note that two files of the same 
type cannot be played at the same time anyway so this is only relevant if you are playing a midi track and 
want to launch a WAV file or vice versa.

Report Text
This feature allows you to record a piece of text to a file on your user's hard disk and is set up via the 
Report tab. You type the text you want recorded into the box provided and then name the file you want it 
saved into. If this file does not exist Illuminatus will create it for you. If it does exist you can either 
Overwrite it or Append the text to the end of the existing file by checking the appropriate option.
This can be used for scoring or recording your user's responses or progress and could be subsequently 
analysed and processed by an Extension.

Captions
To add a caption to a button simply type it into the box provided. Unlike standard buttons you can have 
multiple lines on an Illuminatus button. The caption will automatically be centred in the button both 
horizontally and vertically.

Invisible
By checking the Invisible option buttons can be used as hotspots as they are not visible but can still 
perform the action assigned to them. They can be placed on a graphic so that when the user clicks on the
graphic he/she is clicking on the invisible button. Hotspots



Hotspots
By checking the Invisible option on the Summary of Button Options dialog buttons can be used as 
hotspots as they are not visible but can still perform the action assigned to them. They can be placed on a
graphic so that when the user clicks on the graphic he/she is clicking on the invisible button. 

By highlighting specific words in your text and using an invisible button beneath it you can simulate 
hypertext.

Button Setup



Slideshows
You can set up a slideshow to play in any Illuminatus frame. This feature allows you to setup a series of 
bitmap graphics to appear at intervals of your choice. 

The Slideshow tab brings up a dialog allowing you to locate pictures using the file list boxes.You can then 
add these to your slideshow by clicking the Add button or simply by double clicking on the file required. 

The Delete button removes selected files. The Up and Down buttons move the selected file up or down in 
the slideshow.

Slideshows can consist of only one picture and so (with the Delay option) allow for timed display of single 
elements on your page.

A slideshow can be launched by a button and/or can start automatically by checking the AutoStart option.

The slideshow can be made to fit each picture into the frame by using the Scale to Fit option and can 
retain the original proportions using the Keep Aspect option.

Special Effects
You can choose the way the pictures appear in a slideshow by using the Effects option but these effects 
apply only to bitmap graphics. 

Animations
By building a slideshow from the frames of an animation created by a bitmap animation package such as 
Animation Works Interactive or by creating them manually in a paint program you can create your own 
animations in Illuminatus. You need to set the timing of the slideshow to 0.1secs for smooth animation. 
The speed of animation will depend on the size of the graphics you are using and the speed of your users
computer. 

This can, however, be particularly useful for producing animated buttons, several of which are provided 
with the program.

Related Topics
Recreating Standard Presentation Effects



Launching Other Programs
Illuminatus allows you to program buttons to launch other programs. Any button can launch a program by 
selecting the Launch Program option and then typing in the filename of the program you want to run or 
using the file list boxes to find it. If the program needs a parameter or you want it to start with a particular 
file you can include this in the With Parameter box. If you want these files distributed with your publication
you can check the Distribute option. 

You can choose whether Illuminatus closes down after it has launched the program by selecting Close 
after launch; if    you want Illuminatus to continue running in the background you should leave this option 
blank.

This is the function which enables you to extend Illuminatus with Extensions. You launch you chosen 
extension which performs the additional function for you and then either simply drops back into your 
publication or relaunches your publication giving it a page number to jump to, as a parameter if required. 
Further Details Extension Programs

This also means it can be used as a front end for a compilation of programs or even a front end for a 
series of Illuminatus publications.

When you publish a multimedia publication you can choose to distribute this program with your 
publication and to add any other files it needs to run (.DLLs etc).

Don't forget that to include these programs in your multimedia publication you must have a licence to do 
so or the program and associated files must be public domain.



Extension Programs
You can extend Illuminatus to do anything you want by linking it with ILX extension modules or executable
programs. These are programs which add specific features to Illuminatus in a modular way so that the 
basic program remains uncluttered and you can focus on the extension separately from the interactive 
multimedia packaging. Illuminatus has been specifically designed to allow this modular extension in a 
seamless way to give you whatever functionality you require while keeping the amount of baggage which 
must be distributed with your program to a minimum.

If you are a programmer yourself then you can create extension programs in any Windows programming 
language. A developer's kit is available for assisting with this process and for creating .ILX files. If you are 
not a programmer then you simply buy the module you need from ourselves or buy programs from other 
third parties and concentrate on the part of the multimedia publishing process you want to.

Moving to a Specific Page
Extension modules and other    can be launched using the Launch Program function and can either run 
over the top of your publication page or can replace it. If you want the extension program to return you to 
a certain location in your publication your extension program should rerun your publication with the title of 
the page you want to be displayed first passed as a parameter. Illuminatus has been specially designed 
so that if you have not closed it before running your extension module it will not restart but will simply 
move to the page you have requested. For example to go to the Contents Page of a publication with the 
filename Catalog.Exe your extension program would close down by issuing the command... 
"CATALOG.EXE CONTENTS".

Ideal uses for this function are search programs, order programs, specialised picture viewers, scoring 
programs and printing programs. Several of these are available from Digital Workshop at a small extra 
charge.

See Also
Launching Other Programs



Selecting and Moving Pages
Selecting pages in Illuminatus works just like multiple selection in File Manager and other Windows 
programs. 

You can select any single page by clicking on it with a single mouse click.

To select a range of pages click on the first page. Then hold down the Shift key and select the last page in
the batch. All the intervening pages will be automatically selected.

To pick a scattered selection of pages click on the first page, hold down the Ctrl key and then click on all 
the other pages you want in the batch individually.

In all the above cases to deselect a page simply click on it again. If there are multiple pages selected and 
you are pressing Ctrl only that file will be deselected.

To quickly select all the pages in a publication use Select All from the Edit menu option. There is a similar 
option to Deselect All if you need it.

You can cut, paste, delete, save and print the pages you have selected.

To reorder your pages simply select the page you want to move and drag it to where you want it placed.    



Mulitple Publications
Illuminatus allows you to have more than one publication open at one time. It will open a separate window
for each publication and you can move, resize and minimize these publication windows just like the main 
window though they always remain within their "parent" window. 

You can also use the Window option on the menu bar to close and reorganise your windows. Selecting 
Tile from this menu is very useful when you want to view two publications or pages together.

The number of publications you can have open at any one time will depend on the amount of memory, 
system resources and hard disk space you have available.

Having multiple publications open enables you to cut and paste pages between publications. This saves 
you recreating a page you have used in one publication and now want to use in another. Simply open 
both publications and select Tile from the Windows menu option. Click on the page you want to 
copy and click on the Copy button on the toolbar or select Copy from the Edit menu. Then click on
the window of the publication you want to paste the page into and select Paste from the edit menu
or click the Paste button on the toolbar. You cursor will change to show you are holding pages 
and you can paste them into your publication by clicking at whatever point you want them to go.



About Master Pages
Illuminatus allows you to save any page to disk as a master page. All the elements and contents of your 
page are saved with it. See Save As Master Page

The idea of Master Pages is to allow you to lay out elements which you want to use across all or most of 
the pages in your publication. A typical use for a Master Page would be to hold a background design for 
the whole publication and a company logo or the motto for the presentation which you want to appear on 
all the pages. This is very useful for giving the publication a consistent appearance.

If you need a similar page for most of your publication but also require some page designs for which the 
relevant Master Page is not appropriate these can be inserted and edited individually as required.

Once included in your publication the Master Page can be edited to suit particular page requirements.

Master Pages are also useful to establish consistent colour schemes across a series of pages. Instead of 
colouring the same elements repeatedly across a series of pages colour one, then save it as a Master 
Page. Then insert it again as many time as you require. Even if subsequent pages have some differences
it can be quicker and easier to edit a Master Page than to start from a blank page or template.

You can use Copy and Paste to reuse pages in a similar fashion while you remain in the Illuminatus editor
although, obviously, these pages are not available to be reused in subsequent publications.

Related Topics
About Templates
Save Page As



Creating Your Publication Efficiently
Experience has told us the following process is the most efficient way to create a publication using 
Illuminatus.

1: You will need to have a fairly good notion of the publication you want to create before starting out. With 
projects involving lots of pages and buttons it will be useful to have a definite plan for the publication. It 
will probably help to break the publication down into sections with a menu page for each section and 
subsection.

Things you will need to consider are the resources you have available, the maximum number of buttons 
you will need the number and position of frames, the size of resources you want to use.

2: Select or create a basic page design which is best suited to the bulk of the pages you want to use.

3: If required select or create an appropriate Cover/Contents and other primary page which looks and 
works consistently.

4: Build one copy of each page design you will be using into a new publication. These will be your master 
pages.

5: Create everything which will be consistent across your entire publication. This will probably include:
a background colour or graphic for the whole page,
a background colour or graphic for frames,
a company logo/motto and.or title for the publication,
borders for frames,

also create anything which will be consistent across the majority of your publication.
an Exit button,
a button for a particular page which needs to be reached from most other pages (e.g: contents or 

index),
hotspots,
hide buttons and frames you are not using on most pages.

You should also create sample text in the frames and set up the font, alignment and colour you will be 
using most consistently. This means that for every new page you create you will only need to edit the text 
and possibly font size rather than repeatedly selecting font and colour. 

6: Once you have edited the pages save them to disk as pages or as master pages.

7: Insert as many copies of your half-finished pages as you need and you are already half-finished.

8: Rename the pages to ensure there is no confusion. Ensure that any page you are connecting a button 
to has its final title.

9: With any publication over a few pages it is as well to divide it up into sections. Complete each section 
individually before moving to the next. Link it to a button on a contents page.



About Templates
Page Templates
Page Templates are the bare layouts for pages which are the fundamental building blocks of a multimedia
publication. Each Page Template consists of a design of frames (to contain the graphics and text of the 
publication) and buttons (to control the actions of the publication).

Template Styles
The Page Templates supplied with Illuminatus are divided into various sets. These sets are intended to 
provide a range of similar style templates allowing you to build a consistent-looking publication easily. 
Many have also been given titles to indicate possible uses.

User Templates
You can save templates you have edited or created from scratch using the Save Page as Template from 
the File menu. If you want to be able to show just these templates in the open template dialog box you 
should give the template a filename with "USR" as the first three letters. This enables the program to 
display it when you select User Templates from the List Files of Type drop down list.

Publication Templates
Publication Templates are simply collections of page templates allowing you to save the basic design and 
layout of whole publications ready for regular use. They are ideal for users who regularly publish 
programs or publications of a similar design - a regular newsletter, a monthly sales report or similar.

In the publication templates supplied with the program only one of each style of template is included in 
each template. Each page type can then have the common elements and properties defined before 
saving it as a master page and inserting it again or repeatedly cutting and pasting to build the number of 
pages required.



Compile
This is the function which allows you to build a finished and independent copy of the publication onto your
own hard disk. It is useful when creating presentations which will be viewed on the same computer they 
were created on (e.g: rolling demos) and for testing the true functionality of the publication (the Preview 
option within the Illuminatus editor works very differently and is, in particular, a great deal slower than the 
final version of the publication).

If you have not saved your publication you will need to do so. You will also need to give your multimedia 
publication a title before you Compile or Publish it. This is not the same as the filename for the publication
it is the title used in the menu bar and is required by Illuminatus to set up the data for your publication. 
Illuminatus will remind you about these two requirements if you try to publish or compile without them. 
(See Installation Setup for further details.)

You can choose the number of colours you want your publication created in by clicking on the appropriate
button. The amount of colours you use will affect the size of the finished publication (mono being the 
smallest, 256 colours the largest). A new feature of Illuminatus means that if you publish or compile for 
256 colours and your customer uses the publication on a 16 colour system Illuminatus will automatically 
dither the publication to the restricted colour scheme in the most attractive manner possible.

If you have the DOS Publisher Extension you can choose between Windows and DOS publication here.

Related Topics 
Publish
Installation Setup
Publication Options
Preview



Publish
This option allows you to produce an independent multimedia publication for distribution to other 
computer users. It gathers all the files you have used together, allows you to add others if you wish and 
then bundles everything together, compresses it all and writes a setup program to install it on your 
reader's computer.

Although the published version of the program is intended for distribution on floppy disk you should 
publish it onto your hard disk. and then copy it to the floppy using File Manager. This is much faster and 
means you have a reference copy of the publication on your disk.

Disk1, Disk2 Subdirectories
The Publish operation will break the complete publication into pieces of the correct size for the disk you 
are publishing it for. It then places each of these sections into a separate subdirectory in the directory you 
chose so that they are easily separated. These subdirectories are called disk1, disk2 etc. To copy your 
publication to floppy simply copy the files contained in these subdirectories to the first, second, third 
floppy disk of your publication as required.

Larger Than Floppy Publications
If you want a publication to fit on a removable hard disk, an optical drive, tape drive or other medium with 
larger capacity than the floppy options provided you can either Compile it and then copy the working 
version to the large capacity media or you can Publish the publication to 1.44Mb floppies and simply copy
all the resulting data files to the same location on the large capacity media. The setup program will ask for
disk2, disk3, etc but you can simply press Enter as the data files will be there already.

What You Need To Do Before Publishing
If you have not saved your publication you will need to do so. You will also need to give your multimedia 
publication a title before you Compile or Publish it. This is not the same as the filename for the publication
it is the title used in the menu bar and is required by Illuminatus to set up the data for your publication. 
Illuminatus will remind you about these two requirements if you try to publish or compile without them. 
(See Installation Setupfor further details.)

Choose the number of colours you want your publication created in. If you have the DOS Publication 
Extension you can choose between Windows and DOS publication here.

Related Topics
Compile
Installation Setup
Publication Options



Keyboard Shortcuts
The following keyboard shortcuts are available in Illuminatus.

New Publication Ctrl+N
Open Publication Ctrl+0
Save Publication Ctrl+S
Print  Ctrl+P

Exit Alt+X
Summary Info Ctrl+I

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Delete
Select All Ctrl+A

Edit Selected Page Enter
FirstPage Home
LastPage End
NextPage Page Up
PreviousPage Page Down

Preview F5
Compile F8
Publish F9

Switching between 
Page View 
and 
Publication View Enter



Commands
A comprehensive guide to all the commands and functions in Illuminatus.

GENERAL

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

PUBLICATION VIEW 

File
New...

New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project

Print
Printer Setup
Summary Info
Preferences
Exit

Edit
Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page

Publication
Publication Options
Installation Setup
Insert Blank Page



Insert Page Template
Insert Page
Insert Master Page
Compile
Publish
Preview

PAGE VIEW 

File
Save...

Save Publication
Save All Publications
Save Publication As
Save Page As
Save As Master Page
Save Page As Template

Export Page
Print
Printer Setup
Return to Publication View

Edit
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Top
Bottom
Left
Right

Page
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Export Page
This function allows you to export a full size copy of your page to a disk-based graphic file so that you can
edit it or cut out portions using a paint program such as Paintbrush. If you are running in 256 colour mode 
the exported graphic will be a 256 colour graphic. If you are running in 16 colour mode the graphic will 
reflect that.

Useful hint
One use for this is to quickly turn text into graphics. Export the page and then cut out the pieces of text 
and save them as graphics. You can then use these graphics of your text to create text slideshows and 
other standard presentation effects. You can temporarily give the relevant frame a border for reference 
when you come to cut the item out. 
Another simple use for this is to flip or invert a piece of the background texture or to draw a white line 
around the top left and black around the bottom and right to create and embossed or inset look to a 
frame.



Resources & Data Files
The main focus of    this version of Illuminatus is to provide a quick and easy way to bring together all the 
multimedia resources which are now available.

Illuminatus supports all major graphics formats as well as industry-standard formats for music, video and 
animations; and thereby enables you to immediately utilise all your existing resources in your multimedia 
documents.

Links with Resources
Illuminatus uses most resources directly from the original files on your hard disk. This ensures that any 
changes you make to graphics, animations or large text files will be automatically reflected in the 
multimedia publication using them.

You can check that all the graphics, text, animations, sound and video files used in your publication have 
not been deleted or lost by using the Check Location option from the Data Files submenu on the File 
menu. This option gives you the chance to check and reassign the location of your resource files. 

If you edit a publication which was originally started on another drive or if the resources in your publication
are labeled with a different drive you can use the Change Drive option to correct this. Suppose, for 
example, you are trying to edit a publication on your "C" drive which was originally on a CD Rom in your 
"D" drive and so expects to find all its resources on D:\. Use Change Drive to update the links with 
resource files to reflect the change of drive while retaining any directory and subdirectory information.

To help you maintain you project easily and ensure all the files you need for a publication are available to 
it Illuminatus includes an invaluable function which copies all the resource files the publication uses into 
the same directory as the editable file. This the Consolidate Project option on the Data Files submenu. 
Data Files

Text of less than 100 characters and captions for buttons are stored in the program and not in a file on 
disk.

Links with Other Programs
You can launch programs to edit your text files, graphics and sound files from within Illuminatus using the 
appropriate options on the Tools menu. The default set up uses the programs which come free with all 
copies of Windows namely, Write (for word processing), Paintbrush (for picture editing) and Sound 
Recorder (for sound editing). You can, however, change these to suit your own particular favorites by 
using the Setup Tools option on the bottom of the Tools menu.

Remember when using word processors to create and edit text for your Illuminatus frames that you must 
save or export the file as basic DOS or ASCII text.

Text
Graphics
Sound
Moving Images



Data Files
This option allows you access to a submenu provided for reorganising the links between your Illuminatus 
publication and the resources used in it.

Resources & Data Files
Check Location
Change Data Drive
Consolidate Project



Check Location
This option allows you to check that all the graphics, text, animations, sound and video files used in your 
publication are where Illuminatus expects them to be and have not been deleted or lost. If they are not 
your publication will have blank or partially blank frames and pages.

When you run this option Illuminatus checks the links with the files and lets you know if any can't be 
found. If the file is missing Illuminatus asks you if you want to reassign the file. You can then either locate 
the original file or find another file to replace it. 

Resources & Data Files
Change Data Drive
Consolidate Project



Change Data Drive
This option allows you to change the drive where Illuminatus will look for the data files and resources 
used in your publication while retaining any directory or subdirectory information.

If you have copied a publication from one drive to another for example, or if you are trying to edit a 
publication on your hard drive (C:) which is expecting all your resource files to be on a CD Rom in your 
drive (D:) or vice versa. 

Resources & Data Files
Check Location
Consolidate Project



Consolidate Project
This invaluable option allows you to quickly pull together all the components of your multimedia 
publication and store them in a single place alongside your editable Illuminatus file.

When you select this option a File Save dialog appears and allows you to choose a filename directory for 
your consolidated project. Usually these will be the same as the current filename and directory but you 
can move and/or rename your whole project by typing a different directory or filename in the dialog which 
appears.

Once you've clicked on OK Consolidate Project will gather together all the resources used in the project 
and put them into the same directory as the Illuminatus editor file (*.MPB) as selected via the File Save 
dialog. It will then reassign all the references in the publication to the new location. Illuminatus includes 
any files referenced in the publication whether they are actually used in the publication or not. This 
ensures that if you switch a slideshow back on all the files it needs will have been consolidated and you 
won't have to start all over again.

Once you've consolidated your project you can then safely delete any working files not copied to the 
consolidation directory in the knowledge that you didn't use them.

Check Location
Change Data Drive



Text
Captions for buttons, titles and short pieces of text can be typed directly into Illuminatus. Larger amounts 
of text are stored in individual files on disk. This is to allow you to work on your Illuminatus text using your 
favourite Word Processor and for those changes to be automatically reflected in your multimedia 
publication.

You can still type large amounts of original text within Illuminatus. The program will ask you for filename to
store it in once the text gets too long.

Note: When you import a text file from disk and click OK to use it in your frame Illuminatus will ask you for
a filename as though you had typed it all in yourself - this is because you may have edited it within 
Illuminatus and you are therefore given the opportunity to save it under a new name. If you have not 
edited it or if you have but want the original disk file updated you can simply save it under the same 
filename.

Text Attributes
Fonts

Graphics
Sound
Moving Images



Graphics
Graphics are very important in Illuminatus. They can be used as backgrounds or illustrations in both 
frames and page backgrounds or they can impose a design on an Illuminatus page as several of the 
backgrounds supplied with the program do.

To import a graphic simply click on the frame or page background you want the graphic to be in and then 
locate the file you want by using the file list boxes at the bottom of the Background dialog. 

Checking the Scale to Fit option will resize the picture to fill the background, with the Keep Aspect option 
checked the picture will not be stretched out of proportion in order to make it fit. The scale to fit option is 
not relevant for vector format pictures such as .WMF or .CGM.

ClipArt
Illuminatus supports all the major graphics formats and so enables you to utilise your existing graphics 
and draw on the wide range of clipart available from ourselves and from third parties

Formats Supported
Illuminatus will import the following graphics formats: .BMP. .PCX. .TIF, .GIF, .TGA, .WPG, JPEG, .WMF 
and .CGM

Palettes
If you are displaying 256 colour graphics in super VGA 256 colour mode it stands to reason that 
displaying more than one graphic may need more than the 256 colour slots available. This can cause 
problems if you want to display two or more 256 colour graphics on the same page as the palettes of the 
two graphics may be different and interfere with each other. 

One alternative is to use 16.7 million colours but this can be slow and is not really suitable for publications
intended for wide distribution because it relies on the reader having a system capable of running in such 
high colours. A second alternative is to use a paint or graphics conversion program to reduce the number 
of colours to sixteen (if this can be done attractively) or to convert the files to greyscale as the palette for 
all greyscale images is the same.

Sound
Moving Images
Text



Sound & Music
Sound and music can make a most effective impact on your multimedia publication but you and your end 
user need a specialised sound card to enjoy the effect although you can persuade the PC speaker to play
sound effects using a special Speaker Driver program which is available from bulletin boards and 
shareware libraries if a sound card is unavailable.

However, there is no need to do two versions of a multimedia publication or to avoid music because you 
are not sure all your users will have a sound card. Your multimedia publication will not crash if it can't play
the music it will simply carry on silently.

You can stop a music file by assigning a button to play a sound without giving it a .MID file to play, i.e: by 
playing an empty sound.

Sound
Microsoft's .WAV audio format is best used for short spot effects rather than background music as it does 
not operate very well on sound files over 60 seconds long. Indeed, files are best restricted to 4 secs if 
possible as this ensures they are used in one chunk. The length of this chunk can be extended to 8 
seconds via the Setup option for the MCI Sound driver in the Drivers section of the Windows Control 
Panel but your readers will need to have it similarly setup if you are to rely on it. 
The possible consequence of an audio file too large for this buffer is that if your multimedia publication is 
doing something else at the same time (an animation, demo or similar) particularly if it is reading from the 
hard disk the sound file may stop and start.

Music
The industry-standard MIDI format is the best option for adding background music to your publication as 
Midi files can be any length and do not require the large amounts of system resources which WAV files 
can need.

You can add background music to your publication by starting the music on your first page (via the Sound 
item on the Page Options dialog) and switching off the Stop on Next Page option.

Most professional musicians are familiar with this format and compose for it and there is a good deal of 
good quality Midi music available from third-parties or public domain.
The limitation of this format is that rather than record the actual sound of an instrument it is a series of 
instructions which are sent to the digital instruments (voices) built into your sound card. Some of these 
mimic the instruments they are meant to be very well while others do not. This is particularly true of 
drums, trumpets and stringed instruments. If a piece of midi music uses instruments your sound card 
doesn't support very well the results can be appalling.

The most popular range of soundcards is the SoundBlaster series and if you are distributing your 
publication widely it will be as well to ensure it sounds best on the SoundBlaster. 

To get even better quality from the SoundBlaster Pro cards a special driver is available from the 
manufacturer which considerably improves the quality of the instrumentation under Windows.

All the midi music supplied with Illuminatus is intended for optimised for such a setup.

Graphics
Moving Images
Text



Moving Images
You can assign an animation or video clip to play in an Illuminatus frame by selecting the relevant file 
using the file list boxes at the bottom of the Animation section on the Frame Options dialog. As with most 
elements in Illuminatus you must give the resource a title by which it is known throughout the program. 

The animation can start up immediately the page is opened using the AutoStart option, or it can be 
synchronised with a later event using the Delay option. 

The Scale to Fit and Keep Aspect options only apply to AVI video files and not to animations but you can 
set the Loop option to make the animation play repeatedly.

Animations
Illuminatus supports the industry-standard .FLC and .FLI formats of animation. These are the native 
formats of the Autodesk range of animation products - Animator, Animator Pro and 3D Studio but they are 
supported by a wide range of other programs and utilities.

There are large numbers of such animations available on bulletin boards or from third parties and many 
companies can produce them to order.

Video
Illuminatus supports the Microsoft Video for Windows AVI format. There are an increasing number of 
video clips in this format available in collections from third parties. You cannot play more than one video 
file at any one time. If you want more than one movie playing on a page you must use slideshows or 
animations.

Slideshows
You can also create simple animations using the inbuilt slideshow function.

Graphics
Sound
Text



Important Considerations
Volume Levels
WAV and MID files are produced differently on any soundcard and the difference in the volume levels can 
be quite considerable. Your sound card may come with a mixer utility which allows you to set up the 
relative volumes of playback. With SoundBlaster this is the SBMixer utility. Adjust the controls until WAV 
and MID files are played back at equal volumes. 

Page Zoom
Please note that some details of the page may not be properly visible if the page is reduced too much. 
This is particularly true of any colours which are dithered.

Distributing Other Programs
When you want a button to launch a program for you Illuminatus will need the complete location for the 
program (e.g: "c:\windows\calculator.exe"). If the program is distributed with the publication this is not 
necessary as Illuminatus will put it into the same directory as the publication so that it knows where to find
it.

There is an option which allows you to include the program with the distributable version of the publication
so that it is installed on your reader's computer. This is the only way to ensure that the reader has the 
program and that it is currently installed. But obviously you can only distribute these programs if their 
copyright-holder allows it or if you have a licence to do so.

You will also need to ensure that Illuminatus also distributes any supplementary files the program needs 
(e.g: special drivers, sound files or .DLL's). A dialog asking for details of supplementary files will prompt 
you when you set up a button to launch a program.

Other files
All the elements you include in the publication (graphics, text, sound, animation, video clips) are built into 
the distribution file when Illuminatus creates you publication so there is no need to distribute the original 
files.

Text
Remember that even users familiar with computers are not as used to reading screens as they are paper. 
If you need a lot of text for any reason try to break into down into manageable chunks. This is particularly 
important in rolling presentations where text should be a large bold style so that it can be read at a glance
and get its message across quickly or entice the viewer in to read the smaller text. Avoid large amounts of
text unless the publication is an online book. If you have a lot of text to display split it over several pages 
and make it exciting to look at.



Other Hints and Tips
Cutting and Pasting Text
You can cut and paste text between the Illuminatus Text box and any other Windows application using 
Ctrl+C for Copy and Ctrl+V (or Shift+Insert) for Paste.

Using Export Page
One use for the Export Page option is to quickly turn text into graphics. Export the page and then cut out 
the pieces of text and save them as graphics. You can then use these graphics of your text to create text 
slideshows and other standard presentation effects. You can temporarily give the relevant frame a border 
for reference when you come to cut the item out. 
Another simple use for this is to flip or invert a piece of the background texture or to draw a white line 
around the top left and black around the bottom and right to create and embossed or inset look to a 
frame.

Speed of Operation
You can speed up the program during editing by switching off the thumbnails used to preview pages in the
Publication View and by not previewing bitmaps in Page View. Both of these options are available from 
the Preferences item on the File menu.

For obvious reasons display of multimedia pages from within the Illuminatus editor using the Preview 
option will be considerably slower than the final Compiled or Published version.

Creating Illuminatus Pages in Your Favourite Application
If you want to create your pages or parts of your pages in other applications you can do so. You can even 
go so far as to design the whole page in another application and then either export it as an appropriate 
size bitmap, or as a vector (.WMF or .CGM) graphic or simply grab a screenshot using Alt-PrintScreen. 

The result can be imported into an appropriate Illuminatus frame and the buttons connected as required.

Getting Bitmaps the Right Size
Bitmap graphics will invariably work best if they are the same size as the frame they are going into. This 
especially important for sixteen colour graphics. If sixteen colour graphics are dithered reducing them to fit
in an Illuminatus frame can give them an unwanted tartan effect. 

In the status bar at the bottom of the screen Illuminatus tells you the size and position of the button or 
frame you have selected.

If you are creating your bitmaps specially you may find it helps to save the Illuminatus page or the page 
template you are using them in as a bitmap using Export Page (see Export Page) from the File menu in 
Page View. You can then load this into your paint program and use it for reference in creating your 
bitmap.

Rolling Demos
For rolling demos variation in the graphics is most eye-catching. Changes in the predominant colour of 
the screen and strong main graphics can be most effective in exhibition situations where attention-getting 
is the key. This can, however, make the presentation uncomfortable to read so for shop windows it is less 
useful. In both cases a consistent basic design should be maintained to let viewers quickly read the 
information you are presenting once you have caught their attention.

Background Music and Sound Effects
You can play a WAV file over the top of a MID file without stopping the latter. So you can, for example, 
use a MID file for the background music and then use a WAV spot effect or fanfare over it as required. 
Don't forget that AVI files can have WAV sound tracks in them and so can interrupt any other WAV files 



you have running.

SoundBlaster Pro
If you have a SoundBlaster Pro card we recommend you get the Super SAPI driver for it as this greatly 
improves the quality of output under Windows.

All the midi music supplied with Illuminatus is intended for optimised for such a setup.

Frame Borders
The Frame Options dialog allows you to switch the border for a frame on or off (by choosing None) or to 
add one of several different styles. To add more sophisticated borders you can use frames within frames. 
Use the outer frame to hold a graphic border for the text, graphic, animation or video in the inner frame.

Video and Animation Preview Bitmaps
Frames in which video or animations will run can leave large empty gaps but you can grab a frame from 
the video to use as a preview as follows:
Run the Media Player accessory which comes with windows and open the appropriate video or 
animation file. Using the slideshow buttons on Media Player step through the individual frames of 
the file until you find one you want to use to represent the file. Copy it to the Clipboard by 
pressing Alt-PrintScreen. Open Paintbrush and Paste the clipboard file into there. You can then 
edit and save the video frame as a bitmap graphic which can be displayed in the same Illuminatus 
frame that the video or animation itself will appear in. 

Colour Schemes
Colour can be the make or break of any presentation and multimedia publishing is no different. For those 
untrained in design we recommend that the basic design is limited to a neutral colour (grey, black or 
white) with one other colour. Using grey as the main colour gives you dark and light grey, plus black for 
shadows and white for highlights. This will also give the multimedia publication a Windows feel and 
Windows users will feel comfortable with it. This also means that you can easily find examples of colour 
schemes which work and ones which don't by your own response to the colour schemes employed by 
Windows programs.

Sixteen vs 256 colours
Using 256 colours in your publication is always preferable and for scanned pictures, digitised video or 
sophisticated colours it is essential. In 256 colours your graphics will be much closer to photographic 
quality than in sixteen colours. 

It doesn't matter whether your user has a system capable of displaying 256 colour graphics as Illuminatus
has a special automagic feature which recognises what mode it is running in and adapts 256 colour 
graphics to 16 if required. 

The real problem with 256 colour graphics is that they can be very large.

If you wish to create a sixteen colour publication best effects in sixteen colours are achieved by avoiding 
dithered colours wherever possible. Stylish effects can still be achieved using mono or sixteen colour 
graphics, particularly by using bold icon or symbol type images. (Several examples are supplied in the 
samples which accompany this program.) 

If your publication is to be displayed in 16 colours but contains graphics intended for display at 256 
colours (or higher), particularly greyscale or colour scans or photographic images, then you should 
compile it to sixteen colours so that you can examine the consequences. If you want greater control over 
how the sixteen colour graphics are created you should reduce them yourself. We recommend PaintShop
Pro for this as some of the dithering options it offers can be quite attractive in themselves.



NOTE: Both Animator animations and video files will display on standard 16 colour VGA systems but the 
effects may be unpredictable. AVI video general works quite well but the colours in Animator files may not 
convert properly. Animations produced by Windows bitmap animation programs like Animation Works 
Interactive, CorelMove etc. can create sixteen-colour animations which avoid these problems but are not 
suitable where large areas are being animated.

Reducing File Size
If you need to reduce the size of your final publication consider some of the following options. Reducing 
the number of colours in a graphic can also drastically effect the size of the file involved. 
Pictures with lots of    detail and variation in colour or tone will compress poorly so try to replace them with
graphics with flatter areas of colour. 
If you have reduced the number of colours in a graphic using a dithering option try and alternative dither 
as some nice-looking dithers can produce files which do not compress very well at all. 
As a last resort consider whether any graphics can actually be removed. 
Consider replacing WAV files with midi files or removing them completely as these can be very big and do
not compress very well.

Consistent Style
If you a creating a series of documents on the same theme or for the same purpose it is advisable to 
choose a "house style" for your documents. Base the bulk of your publication on one or two page 
template designs - the templates supplied with Illuminatus often have several variations on designs for 
just this purpose. Use this page consistently with the same colour scheme, the same fonts and the same 
position for your company logo or the motto/title for the presentation.

Getting Ideas
Keep your eyes open for other multimedia programs, demonstrations and presentations which work 
particularly well and try to decide what makes them successful. 

Television is a similar medium to multimedia publishing so TV programs, particularly current affairs and 
news programs, can often provide inspiration for page designs or simply illustrate effective techniques. 
You will also see reviews of many multimedia products in specialist magazines which can often prompt 
your own creativity.



Setup Tools
This option allows you to setup your favourite word processor, paint program and sound editor to use to 
edit your multimedia resources via the Tools menu without leaving Illuminatus. 

The default settings are to use the programs which come with Windows namely; Write, Paintbrush and 
Sound Recorder. You can change them by using the appropriate Browse button to find the filename for 
the program you want to use. So, for example, to replace Paintbrush with Corel PhotoPaint you 
choose Setup Tools, then click the Browse button alongside the Paint Program box. Search 
through the directories to find CORELPNT.EXE, select that and then press OK. Now every time you 
choose Picture Editor from the Tools menu Illuminatus will launch Corel Photopaint.



Auto Reset
This option allows you to control what happens to your publication when the user has finished with it and 
it is left idle. Usually you will want it to return to the opening page, alternatively you may want to close the 
publication down (this is particularly useful if the publication was launched from another multimedia 
publication and you want to return to that one).

You can set the time the program waits in seconds by typing the number into the box provided. You can 
then set whether the program closes via the Closedown procedure or whether it resets to a particular 
page.

Note: When setting the reset time don't forget to allow your user plenty of time to read and act on your 
pages or your publication will reset inappropriately.

Closedown



Recreating Standard Presentation Effects
Illuminatus can produce a presentation similar in style to standard presentation packages by using 
slideshows for all the elements of a "slide". Slideshows can consist of only one picture and so (with the 
Delay option) allow for timed display of elements on your page. If you want to use text in this way you 
should convert your text to graphics as follows:

Load a template for a bulleted list. Load a background and colour each of the bullet and text 
frames appropriately. Type in the bullets and text as required. Now save this page as a 
independent bitmap graphic using Export from the Page menu. Take the bitmap into Paintbrush 
and cut each of the elements out and save them to disk as individual picture. 

Now replace the text in the Illuminatus frames with slideshows displaying a single bitmap version 
of the text. By setting the delay for each frame differently the bullet points can appear in any order
your require. 

This can be used in both self-displaying and interactive publications.



Rolling Publications
In addition to creating interactive multimedia documents Illuminatus makes it simple to create stylish self-
displaying publications and demonstrations. Simply design the publication you require just as with any 
other multimedia publication, and then specify the length of time each page will display by type a value in 
seconds into the Timed box on the Summary of the Page Options dialog. 

This allows you to set up the intervals in tenths of a second between each page and the way in which the 
publication can be interrupted.

If you want animations, video or slideshows to appear in your self-displaying publication you need to set 
the AutoStart option for these elements (with a Delay if required). Don't forget to set the timing of the page
long enough to let the animations finish.

By combining slideshows containing just one graphic you can produce most standard presentation styles.

Recreating Standard Presentation Effects



Closedown
Closedown is the overall term for the way your multimedia will close when it has been interrupted or when
the user closes it using a button you have provided for the purpose. 

You play a sound file or piece of music and display an end page for however long you require.

A typical use for the end page would be a copyright notice, a thank you or a reminder of how to order or 
who to contact for further details.

Publication Options



Technical Details
Screen Resolution
Illuminatus currently supports a standard VGA resolution of 640x480. It will run successfully in any higher 
resolution but the pages will remain at 640 x 480 pixels and will be centred on screen. The remainder of 
the screen will be covered with the background colour of the page.

Recommended Display Mode
Illuminatus will run most effectively in 256 colour mode. You can create publications running in other 
graphics modes and on many systems you can compile and publish in VGA or SVGA 256 colour modes. 
However, some VGA display drivers do not offer the functions Illuminatus uses to create pages when 
creating a compiled or published publication unless you are running in 256colour mode. The program will 
tell you when this is the case.

Number of Colours
Illuminatus will support graphics up to 16.7million colours assuming the computer display card and 
monitor are capable of 24 bit colour. These graphics will be automatically converted to mono, 16, or 256 
colours when publishing or compiling.

Distribution Disk Space
The distributable multimedia publication is optimised and compressed as much as possible allowing a 
viable MPB to fit on a single floppy disk. Exactly how much information will fit depends on the type of 
resources you use. Text, midi music and sixteen colour bitmaps will take up less room than WAV files and 
256 colour graphics. A 1.44Mb floppy will probably hold about 20 pages of average material. Video files 
and animations are very large. Much smaller files can be achieved by publishing your publication in mono 
(select the Mono option on the Compile or Publish dialog) although this will reduce the attractiveness of 
graphics intended for use in colour. The overhead for the executable proportion of your publication work is
little more than 280K but there is a small additional overhead for the program which will install your 
publication from disk.



Technical Support
UK & Europe
If you require technical assistance with Illuminatus, call Digital Workshop on 01295 258335 and ask for 
Technical Support. Alternatively you can fax (01295 254590) or post details of your problem to us.

Digital Workshop
First Floor
8 West Bar
Banbury
Oxon
OX16 9RR

We can also be contacted via CIX join theworkshop or on Compuserve, GO WORKSHOP

USA & Canada
Sales and Support for North America is currently provided by 
JASC Inc 
10901 Red Circle Drive,
Suite 340,
Minnetonka,
MN55343

Tel: 612 930 9171 Fax: 612 930 9172

Worldwide
International support is provided via CompuServe, GO WORKSHOP
or at the UK address above.

When you call or write to technical support, please have as much information as possible available 
including the type of computer you are using, the amount of memory installed, the size of hard disk and 
the graphics card you are using. 

If it is possible to have access to your computer when phoning it is usually helpful to have the program 
running on the system when you call.



File (Publication View)
This provides access to file and program management options such as file loading and saving functions, 
printing and program preferences.

New...
New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project

Print
Printer Setup
Summary Info
Preferences
Exit



File (Page View)
This provides access to file and program management options such as file loading and saving functions, 
printing with reference to the current page.

Save...
Save Publication
Save All Publications
Save Publication As
Save Page As
Save As Master Page
Save Page As Template

Export Page
Print
Printer Setup
Return to Publication View



Save Page As
Saves the currently selected page to disk via a standard Windows file dialog to allow you to give it 
filename.



Save Page As Template
This option allows you to save the design of frames and buttons on the current page to disk as a template
which can then be used in future publications via the Insert Page Template option. The page can be 
based on one of the templates supplied with the program or can be one you have created from scratch.

If you want to be able to filter your templates from all the others using the List Files of Type option the first
three letters of the filename for the template must be USR.



Save As Master Page
Saves the currently selected page to disk via a standard Windows file dialog as a master page.

About Master Pages



Return to Publication View
Returns you to the overview of your publication.



New Publication
Creates a new, untitled publication without pages or page templates.



New Publication from Template
Opens a new publication from a skeleton version of a publication (Publication Template) which already 
contains the page templates necessary for the chosen publication. 



Open Publication
Opens a publication previously saved to disk. A standard Windows dialog allows you to browse your 
system for the file required.



Save Publication
Saves the currently selected publication to disk under its existing filename without further ado. If it is 
untitled you will be asked for a filename.



Save All Publications
Saves all the publications you currently have open to disk under their    existing filenames without further 
ado. If any are untitled you will be asked for a filename.



Save Publication As
Saves the currently selected publication to disk via a standard Windows file dialog to allow you to give it 
(new) filename.



Close Publication
Closes the currently selected publication. If the publication has been changed since it was last saved you 
will be given the opportunity to save it.



Summary Info
Allows you to record more extensive details about your publication such as title, who created it, and any 
notes or keywords you want to add. You can also assign it a category. The only role for this information in 
the current version of Illuminatus is to quickly remind you of details of the publication at any time after you
have created it.



Save Publication As Template
Enables the current publication to be saved to disk as a skeleton publication on which to base future 
projects. Only the templates for each page are saved. No text, captions or contents are saved.

This option is useful where you regularly use a consistent layout but with different content. 

Master Pages should be used where some of the content is also consistent.



Print (Page View)
Prints a preview version of the current page to the current Windows printer. For printers using A4 paper 
the output will look best if the printer is setup in landscape mode



Print (Publication View)
Prints your whole publication or a range of pages from your publication, one page per printed page, to the
current Windows printer. For printers using AL paper the output will look best if the printer is setup in 
landscape mode.



Printer Setup
Allows access to the standard Windows Printer Setup dialog to control your printing options. For printers 
using AL paper output from Illuminatus will look best if the printer is setup in landscape mode.



Preferences
Allows you to control several aspects of the way Illuminatus works.

Make Backups When Saving - Whenever you save a publication Illuminatus can keep a backup of the 
previous version for you to revert to if necessary. The backup is stored in the same directory and filename
as the original but has the .BAK ending. You can revert to this version by renaming it to [filename.MPB].

Thumbnails in Publication View - Creates a miniature image of your page and displays this in 
Publication View in place of the blank page icon. It can slow the program down on slower machines.

Show Bitmaps While Editing - Allows you to hide the graphics on your page while you are editing it in 
Page View and so speed up operation of the program. The pictures will still display in Preview.

Show Start Up Dialog - Allows you to launch Illuminatus straight into publication view without the 
prompts on the title page.

Help Tag Colour - Allows you to choose your own colour for the help tags which appear over the toolbar 
to prompt you of the use for the button.

Enable Project Timer - Allows you to turn the Project Timer on or off allowing you to demonstrate 
Illuminatus editing without displaying the time you have spent on the project or without increasing the time
spent on it.

Background Music - Allows you to play background music while you work in Illuminatus. Obviously this 
music stops while you preview your publication.

Initial Zoom - Allows you to specify the zoom setting which Illuminatus will start in when it switches to 
Page View. You can select any of the options available as your default or the program can remember the 
last zoom used.



Exit
Closes the program down, giving you the option of saving any publications which have changed.



Edit (Publication View)
This menu allows you to perform all the standard Windows editing functions on your selected page(s). It 
also allows you to switch to Page View for editing of your Illuminatus page.

Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page



Cut (Ctrl+X)

Removes the currently selected page or pages from their place in the current publication and stores them 
on the Windows clipboard ready to be pasted back into a new position or a new publication if required.

Related Topics
Copy
Paste



Copy (Ctrl+C)

Copies the currently selected page or pages leaving the originals in the current publication and stores the 
copy on the Windows clipboard ready to be pasted back into a new position or a new publication if 
required.

Related Topics
Cut
Paste



Paste
Pastes any page or pages currently stored on the Clipboard. The cursor changes to show you have 
pages to paste and you simply click where you want them to go. 

Related Topics
Cut
Copy



Delete (Del)

Deletes the selected item(s) completely from the publication. In Publication View it deletes selected 
pages.

In Page View it deletes the button(s) or frame(s) you have selected. A dialog will ask you to confirm that 
you want to delete the objects.



Select All (Ctrl + A)
Quickly selects all the pages in a publication. 

Useful for when you want to Copy the whole of a publication ready to Paste it into another.

Related Topics
Selecting and Moving Pages



Deselect All
Quickly deselects all the pages you currently have selected. 

Related Topics
Selecting and Moving Pages



Edit Selected Page (Enter)

Switches the program to Page View to allow you to edit the elements on a page. If you have more than 
one page selected Illuminatus will go into Page View with the first page in your selection.

Related Topics
Frame Options
Button Options



Publication
This menu provides the tools of publishing

Publication Options
Installation Setup
Insert Blank Page
Insert Page Template
Insert Page
Insert Master Page
Compile
Publish
Preview



Insert Page Template
Allows you to insert a ready-made page template from the wide selection provided with the product or 
those you have saved to disk using the Save Page As Template option. These already contain frames and
buttons and are designed in a variety of styles for a variety of roles.

You can limit the list of templates to a specific style by selecting that style from the List Files of Type box 
at the bottom of the dialog.

Related Topics
Selecting and Moving Pages
Insert Blank Page
Insert Page
Insert Master Page
Save As Master Page
About Master Pages



Insert Blank Page
This option allows you to add an entirely blank page to your publication on which you can draw a template
of buttons and frames of your own design.

Once you have selected this option you click in your publication window at the point where you want the 
page inserted.

Related Topics
Editing Page Elements
Selecting and Moving Pages
Insert Page Template
Insert Page
Insert Master Page
Save As Master Page
About Master Pages



Insert Page
Allows you to insert a page which has been previously saved to disk. All its properties and contents will be
included. To build your publication quickly you can check the Multiple Copies option and type the number 
you require in the box provided.

Related Topics
Selecting and Moving Pages
Insert Page Template
Insert Blank Page
Insert Master Page
Save As Master Page
About Master Pages



Insert Master Page
Allows you to insert a page which has been previously saved to disk as a master page. All its properties 
and contents will be included. To build your publication quickly you can check the Multiple Copies option 
and type the number you require in the box provided.

Related Topics
Selecting and Moving Pages
Insert Page Template
Insert Blank Page
Insert Page
Save As Master Page
About Master Pages



Edit (Page View)
This menu provides functions for creating your own page templates or editing existing ones. It enables 
you to add frames and buttons, to align them and to order the layering of overlapped objects by bringing 
selected objects to the front or moving them to the back

To perform any of these options simply select the object(s) required (Use Shift+Click to select multiple 
items) and then choose the appropriate function or click on the relevant button on the toolbar if one is 
available.

Commands
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom

See Also
Editing Page Elements



Add
This command allows you to draw your own frames and buttons on the page. You can either start with a 
blank page by using Insert Blank Page from the Publication menu in Publication View or you can add 
frames and buttons to an existing page template.

If you want to use the template you have created in future publications you can save it to disk using the 
Save Page As Template option in Page View.

Add...Frame
Add...Button



Add...Frame
This option allows you to draw a frame anywhere on your page. You can start with a blank page or an 
existing page or page template. Once you have selected this option click on your page at the point where 
you want the top left corner of your frame to be and drag down and to the right until the frame is the right 
size and shape. Note that the size and shape of a selected frame is displayed in the status bar at the 
bottom of your Illuminatus window.

You can resize and reshape the frame at any time by dragging any of the eight editing handles which 
appear around it when it is selected. You can also edit the size and position very precisely by editing the 
numbers for Top, Left, Width and Height on the Summary of the Frame Options dialog.

Illuminatus currently allows a maximum of 25 frames on any one page.

Add...Button



Add...Button
This option allows you to draw a button anywhere on your page. You can start with a blank page or an 
existing page or page template. Once you have selected this option click on your page at the point where 
you want the top left corner of your button to be and drag down and to the right until the button is the right 
size and shape. Note that the size and shape of a selected button is displayed in the status bar at the 
bottom of your Illuminatus window.

You can resize and reshape the button at any time by dragging any of the eight editing handles which 
appear around it when it is selected. You can also edit the size and position very precisely by editing the 
numbers for Top, Left, Width and Height on the Summary of the Button Options dialog.

Illuminatus currently allows a maximum of 25 buttons on any one page.

Add...Frame



Move
This option allows you to dictate the order in which frames and buttons will appear on the screen. Please 
note, however, that for technical reasons all frames are drawn first and all buttons drawn over the top. So 
ordering of frames is within the frame "layer" and ordering of buttons is confined within the button "layer".

To Front
To Back



To Front
This will bring a selected frame to the front to appear over the top of any other frames. It will also bring a 
selected button to appear over the top of any other buttons.

To Back



To Back
This will move a selected frame to the back to appear over behind any other frames. It will also bring a 
selected button to appear behind any other buttons.

All frames always appear behind buttons.

To Front



Align
This option allows you to ensure that buttons and/or frames line up neatly. You select a number of frames 
or buttons by holding down Shift and clicking on each of the items required. The eight black editing 
handles appear on each object to show they are selected.
You can now select one of the options to align the frames neatly to top, bottom, left or right.

Left
Right
Top
Bottom



Left
Selecting this option will align the lefthand edge of all selected items with the lefthand edge of the object 
furthest to the left.

Right
Top
Bottom



Right
Selecting this option will align the righthand edge of all selected items with the righthand edge of the 
object furthest to the right.

Left
Top
Bottom



Top
Selecting this option will align the top of all selected items with the top of the object highest up the page.

Left
Right
Bottom



Bottom
Selecting this option will align the bottom edge of all selected frames and/or buttons with the bottom edge 
of the object lowest down the page.

Left
Right
Top



Page
This menu provides control over how your page is displayed.

Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Zoom 50%
Shows your current page at half the size it will display. This view is often a good compromise for users 
running Illuminatus in 640x480 allowing you to see the whole page in reasonable detail.

Related Topics
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Zoom 100%
Shows your current page at the size it will actually display. This gives you the best preview of your page 
without using Preview but unless you are running Illuminatus in a resolution higher than 640x480 you will 
not be able to see the whole page at once. 

Related Topics
Zoom 50%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Zoom to Fit
Scales the view of the current page so that the whole page fits into the current window. When you resize 
the window the page will be scaled to fit the new size. If you zoom to fit when the window is quite small 
you may lose some details of your page and it may be difficult to select the elements you want to edit. We
recommend you use Zoom to Fit with the largest possible window - maximise both Illuminatus and your 
publication window. 

Related Topics
Zoom 50%
Zoom 100%
Next Page
Previous Page
First Page
Last Page
Preview



Next Page
Takes you to the next page in the current publication. 

You can use the Page Up as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Previous Page
First Page
Last Page
Preview



Previous Page
Takes you to the preceding page in the current publication. 

You can use the Page Down key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
First Page
Last Page
Preview



First Page
In Page View. Takes you to the first page in the current publication. 

You can use the Home key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
Last Page
Preview



Last Page
Takes you to the last page in the current publication. 

You can use the End key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Preview



Tools
This option offers you access to programs for editing text, graphics and sound without leaving Illuminatus.

The default settings are to use the programs which comes with Windows, namely Write for text, 
Paintbrush for graphics and Sound Recorder for sound. 

You can change this setting using the Setup Tools option on the Tools menu.

Related Topics
Picture Editor
Word Processor
Sound Editor
Setup Tools



Sound Editor
This option allows you to launch your favourite sound or music editor to create or edit sound or music files
without leaving Illuminatus. When you have finished editing or creating the audio file save it to disk ready 
for use in Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated

The default setting is to use the Sound Recorder program which comes with Windows. You can change 
this setting using the Setup Tools option on the Tools menu.

Related Topics

Sound
Setup Tools



Word Processor
This option allows you to launch your favourite text editor or word processor program to create or edit text
without leaving Illuminatus. When you have finished editing or creating the text save it to disk ready for 
use in Illuminatus. 

You must save it as DOS or ASCII text to use it in the current version of Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated

Related Topics
Text
Setup Tools



Help Menu Option
Contents 
Takes you to the Contents page of this help file.

About
Shows a page showing details of Illuminatus including the version and the licence details.



Window Menu Option
Cascade
Arranges all the windows you currently have open neatly into a stepped array with the title bars showing.

Tile
Arranges all the window you currently have open neatly in a tiled arrangement. 

Arrange Icons
Neatly arranges and spaces the icons of minimised publications at the bottom of the main window.

Close All 
Closes all the windows you currently have open, including minimised ones, asking you if you want to save
those which have changed



Picture Editor
This option allows you to launch your favourite paint program to create or edit graphics without leaving 
Illuminatus. When you have finished editing or creating the picture save it to disk ready for use in 
Illuminatus. 

You can save it in any of the formats supported by Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated.

Related Topics
Graphics
Setup Tools
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Text Attributes
Individual words and phrases can be highlighted by applying attributes to selected text using the buttons 
on the top right of the Text section of the Frame Options dialog. This inserts special codes into your text 
which Illuminatus interprets when it creates the page. A code is inserted at the beginning of the section of 
text to be highlighted to switch the attributes on, and another is inserted at the end of the text to switch the
attributes off as illustrated below. More than one attribute can applied to a piece of text at any time. If the 
font already has that attribute the switching on and off will be reversed.
You can edit these codes manually just as though they were ordinary text and they can included in a text 
file prepared in a word processor and then imported into Illuminatus.

Removing Attributes
To remove text attributes delete the appropriate codes. Don't forget to delete the pair of codes and ensure
you remove the "\" as well. The quickest and easiest way is to drag the cursor over the code and press 
the Delete key.

Attribute Codes
\i = italic
\b = bold
\u =underline
\c =colour, followed by two numbers for each colour as follows
00 =default colour as chosen in font selection box
01 =white
02 =light grey #
03 =bright red #'
04 =bright yellow #
05 =bright green #
06 =bright cyan #
07 =bright blue #
08 =dark grey #
09 =dark red #
10 =dark yellow #
11 =dark green #
12 =dark cyan #
13 =dark blue #
14 =dark magenta #
15 =light magenta #
16 =black #

The settings above would produce the following result.





Ordering the Full Version
Apart from the compile and publish functionality not available in this version the full version of Illuminatus 
includes megabytes of original multimedia clips, specially-written music, fanfares and spot effects, 
backgrounds, photographs, animations and so on.

You can place your order by phone, fax, post at the addresses below:

For your convenience an order form is provided at the bottom of this page. Select Print Topic from the File
menu to print the order form to your default Windows printer then complete and post or fax to the 
addresses below.

You may purchase the full version of Illuminatus from the following vendors. Click on the appropriate 
vendor for further details and an order form.

UK 
USA
France
Rest of the World

NOTE: Prices given are subject to change without notice and are for single user licences



Additional Software
Digital Workshop are developing a range of .ILX extension modules and support software for Illuminatus 
to add even more functionality to the program. Current plans include

ILMTEXT - an extension of the module provided free with this version providing a frame box with scroll 
bars and page controls for handling large amounts of text.
ILMCOPY - for copying files
ILMSWAP - for exchanging pages in your publication
ILMORDER - to provide an order form for customers to complete
ILMANIM - a simple animation program to provide animations which can be overlaid on your pages.

A developer's kit will also be available to help anyone wishing to develop their own extensions.

We also have a range of support products and software including animations, photographs, clipart, paint 
programs etc. which we feel would be of use to Illuminatus users if you would like to receive further 
details on these products please contact us...

Digital Workshop
First Floor, 8 West Bar, Banbury
Oxon, OX16 9RR, UK

Tel:01295 258335, Fax:01295 254590
Intl Tel: +44 295 258335 Intl Fax: +44 295 254590

CIX: join theworkshop
Compuserve: GO WORKSHOP



Ordering in the UK
Select "File-Print Topic" from the menu bar to print this form.
Vendor: Digital Workshop    

Price: £99.95 
(+VAT @17.5% & £2.50 Postage = £117.44 total)
For Single User licence only. Call for details of multi-user licences.

Payment can be made with cheque, postal order or VISA/MasterCard/Access/Delta/AMerican Express 
credit card. 
Make cheques or EuroCheque payable to: Digital Workshop

Fax or Post to:

Digital Workshop
First Floor
8 West Bar
Banbury, Oxon
OX16 9RR
UK

Tel: 01295 258335
Fax: 01295 254590

Name......................................................................................................

Address..................................................................................................

..............................................................................................................

..............................................................................................................

..............................................................................................................

Post Code..............................................................................

Tel:........................................................................................

Please charge my ....................................................................credit card

No:.................................................................................. Exp................

Signed:...................................................................................................

VAT No:.........................................................................(EC Companies)

Illuminatus @ £99.95 ...................
DOS Publisher Extension @ £37.50 ...................
ILMCD Audio CD Extension @ £19.95 ...................
Extension Pack 1 @ £19.95 ...................

plus postage @ £2.50 £2.50
VAT ...................

Total ___________



Ordering in the US
Select "File-Print Topic" from the menu bar to print this form.
Vendor: JASC Inc 

Price: $149.00 

For Single User licence only. Call for details of multi-user licences.

Payment can be made with check or VISA/MasterCard credit card. 
Make checks payable to JASC Inc

Fax or Post to:

JASC Inc
10901 Red Circle Drive
Suite 340
Minnetonka
MN55343
USA

Tel: 612 930 9171
Fax: 612 930 9172

Name......................................................................................................

Address..................................................................................................

..............................................................................................................

..............................................................................................................

..............................................................................................................

Zip Code..............................................................................

Tel:.......................................................................................

Fax:.....................................................................................

Please charge my ....................................................................credit card

No:.................................................................................. Exp................

Signed..................................................................................

Illuminatus @ $149.00 ...................
DOS Publisher Extension @ $49.00 ...................
ILMCD Audio CD Extension @ $29.00 ...................
Extension Pack 1 @ $29.00 ...................

plus shipping & handling @ $5.00 $..........5.00
(Minnesota Residents add 6.5% sales tax ...................)

Total ___________



Ordering in France
Select "File-Print Topic" from the menu bar to print this form.
Vendor: WindowShare

Bon de Commande Français

Illuminatus pour Windows
LICENCE d'UTILISATION

(Les sociétés peuvent nous consulter pour des licences multipostes ou des licences
multiples)

Remplacez le soulignement par les renseignements demandés.
Imprimez cette fiche, et adressez le tout avec votre règlement
de 990 FF TTC (pour chaque poste), TVA (18,6 %) et port compris à :

WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France
Fax:(+33)87 32 37 75
Vox:(+33)87 30 85 57
Minitel 3615 WinShare

 ____________________________________________________

Nom et Prénom :
____________________________________________________

Adresse : ____________________________________________

____________________________________________________

Code Postal et Ville :
____________________________________________________

Nombre de licences : __________________

Date ______________________

Total TTC ________

Paiement par chèque (bancaire ou postal),
Eurochèque, mandat-lettre, ou carte bancaire.
(barrer la mention inutile)

Carte bancaire, indiquez ici les 16 chiffres et la date d'expiration.

_____________________________________        Exp. : ____/____

Signature :



Merci de respecter le principe du shareware.
____________________________________________



Ordering from the Rest of the World
Please contact Digital Workshop for the latest information on prices and availability for your part of the 
world.

Digital Workshop
First Floor
8 West Bar
Banbury, Oxon
OX16 9RR
UK

Tel: +44 1295 258335
Fax: +44 1295 254590

Or send a Visa/Mastercard/Amercian Express credit card order using the form below.

Name......................................................................................................

Address..................................................................................................

..............................................................................................................

..............................................................................................................

..............................................................................................................

Post Code..............................................................................

Tel:........................................................................................

Please charge my ....................................................................credit card

No:.................................................................................. Exp................

Signed:...................................................................................................






